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Introduction 

Beckhoff Automation 
Beckhoff Automation provides advanced and open automation products based upon proven 
industrial technologies. Beckhoff customers can implement high performance control systems 
faster and at a lower overall cost than traditional PLC and motion control systems. Beckhoff’s 
“New Automation Technology” product range includes PC based control software, industrial PCs, 
automation controllers, operator interface hardware, distributed I/O, industrial Ethernet products, 
servo drives and motors. Sales and service are handled directly, with no intermediaries involved 
to provide faster response and improved technical support.   
 
The TwinCAT suite was put together by Beckhoff Automation to be a complete development 
environment for writing, editing and debugging PLC programs. TwinCAT includes support for five 
industry standard programming languages plus a new variant of FBD. Any of these languages (or 
combination thereof) may be employed to complete your program. 
 
TwinCAT empowers beginner and advanced programmers alike through the use of libraries. 
Libraries contain support code that save the programmer research time. Code that normally 
would have been written from scratch now becomes a call to a specific library. 
 
TwinCAT has a built-in software PLC so programs can be tested without connecting to the actual 
hardware. Furthermore, another program called TwinCAT Scope View is included that offers a 
graphical analysis of the program’s variables which can help with troubleshooting and fine-tuning 
a program, as well as aid in tuning servo systems. 
 
TwinCAT also allows for integration through the use of an interface system that makes it possible 
to interact with the PLC from other programming environments such as Microsoft Visual Studio 
.net using standard DLL and OCX architecture. TwinCAT can also be used to exchange data with 
other systems for example, values in an Oracle database can be called by TwinCAT and the 
resulting instruction sent over the network to yet another system for processing. 
 
 
NOTE: This manual assumes basic to intermediate knowledge of Windows based computers and 
basic programming knowledge. Though someone with any level of knowledge will benefit from 
the instruction in this manual, users are encourage to take classes in the two disciplines 
mentioned above to better grasp the concepts presented here. 
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I/O 
I/O, or Input/Output, refers to communication between a computer and its users, its storage 
devices, other computers (via a network) or attached hardware. Generally speaking, a device 
receives Input and delivers Output. But keep in mind that what is defined as Input or Output can 
change depending on what is being discussed and the particulars of the interaction, for example 
a printer receives Input from a computer (what to print) but the computer can also receive Input 
from the printer (e.g. low ink alert). 
 
In the Beckhoff world, we usually are referring to fieldbus components when we talk about I/O. 
Fieldbus components basically describe how the controller connects to what is being controlled. 
In simplistic terms, the program to control an assembly activity uses fieldbus components to “talk” 
to the assembly machinery. 
 
I/O components include Bus Couplers (Ethernet, fiber optic, PROFIBUS, RS232/RS485, etc.) 
and Bus Terminals (digital and analog input/output). These devices and more act as liaisons 
between the computing device (computer or embedded CPU) and the machines, systems 
(database, etc.) and other computing devices in your facility. 
 
Important aspects of I/O that will be discussed later are: throughput, latency, and whether the 
communications are synchronous or asynchronous. This will be important in determining what I/O 
components and infrastructure will provide the best results given the infrastructure budget. 
 
You can use the catalog (described in the next section) to explore the different components 
available. 

Unit 
A unit consists of a Bus Coupler, Some number of Bus Terminals (dependent on the model of 
Bus Coupler and available extension hardware) and one end terminal. The terminals handle the 
individual inputs and outputs while the Bus Coupler handles communication between the 
terminals and between the Unit and the fieldbus. 

Bus Couplers 
There are a number of different Bus Couplers, supporting different types of 
communication and other specifics. Model numbers are a two-letter code followed 
by a two-digit type code followed by a two-digit form code. BK9100 would describe 
a standard Ethernet Bus Coupler without onboard processor.  
 
Letter codes:  
BC – onboard processor; 
can run in isolation. 
BK – no onboard processor; 
needs a PC to function.  
BX – eXtended, has extra 
communication ports. 
LC – Low Cost 
 

Type codes: 
11 – EtherCAT 
2x – Lightbus 
3x – PROFIBUS 
4x – Interbus 
51 – CANopen 
52 – DeviceNet 
70 – ControlNet 
71 – CC-Link 
73 – Modbus 
74 – Fipio 
75 – SERCOS 
80 – RS485 
81 – RS232 
90, 91 – Ethernet TCP/IP 
95 – USB 

Form codes:  
00 – Standard 
10 – Economy 
20 – Economy Plus 
5x – Compact 
 
(BC and BK only; LC 
and BX always ends 
with 00

Example of a Low Cost PROFIBUS 
Bus Coupler. 

http://dictionary.reference.com/browse/network
http://dictionary.reference.com/browse/latency
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Bus Terminals 

Terminals come in a number of varieties as well depending on the needs of the 
system. Model numbers are a two-letter series code followed by a single-digit type 
code followed by a two-digit sub-model code and ending with a single-digit channel 
code. 
 
One place to begin thinking about appropriate components is the difference 
between KLxxxx (standard) Bus Terminals and ELxxxx (ultra high-speed) EtherCat 
Bus Terminals. 
 

So a standard, four channel, digital input will have the model number of: KL1xx4.   
 
Regardless of the model, terminals are color coded for quick identification: 
Yellow (XX1xxx) – Digital Input 
Red (XX2xxx) – Digital Output 
Green (XX3xxx) – Analog Input 
Blue (XX4xxx) – Analog Output 

 (XX5xxx) – Sensor 
 (XX6xxx) – Communication 
 (XX7xxx) – Power Terminal 
 (XX9xxx) – Power Terminal 

 
Two important Power Terminals are the KL9510 which breaks the power loop, 
separating digital from analog I/O slices, and the KL9010 Bus Terminal which 
closes the electrical loop and must be the very last slice (or the last slice of the last 
chained box). 
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Installation of the TwinCAT Suite 

The TwinCAT Suite is free to download but requires a serial number after 30 days. This will help 
guarantee that your organization does not experience downtime, even during a holiday. 
 

Download and Install 

To download TwinCAT: 

 Go to www.beckhoff.com (enter this URL exactly). 

 Click on Download on the left hand side of the screen. 

 Click on TwinCAT (30 days version). 

 Enter all the fields with a red arrow with real data and click the Register button. 

 You will receive an email from Beckhoff with a link. Click the link to download TwinCAT. 

 Find where the installer was saved (probably the desktop). The file should start with 
“tcat_” followed by the version number. 

 Double click on the file… 
 
Welcome – Click the Next button and then follow 
the instructions on the next page. 
 
 
 

 

 

 

 

CD Install 
To install from the CD: 

 Insert the Beckhoff Software Products CD. 

 Close the browser which will automatically launch. 

 Go into My Computer, right click on the CD drive (it might be titled BECKHOFF) and 
select Explore. 

 Go into the TwinCAT folder and double click on Setup.exe. 
 
 

http://www.beckhoff.com/
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Choose Setup Language – make 
sure English is highlighted and click 
the Next button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Welcome – press the Next button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
License Agreement – after reading 
the entire agreement, click the Yes 
button. 
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Customer Information – verify your 
information. If you have the serial 
number enter it here, otherwise just 
click the Next button; you will be 
able to enter the serial number later. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select Installation Level – select the TwinCAT PLC 
radial button and click the Next button. 

CP – Contains the necessary components for the 
special functions (S-Keys, etc.) of the Beckhoff Control 
Panels. 

IO – The (User Mode-) Program can directly access 

the IO Devices. This Level does not include the PLC. 

PLC – includes the IEC61131-3 Software Development 

kit. 

NC PTP – Enhances PLC with the NC/CNC 

functionality to control the PTP-Axis. 

NC I – Enhances PLC with the NC functionality for 
interpolated drives in 3D. 

 
Select Installation Type – for now, select 30 days 
demo version (you can register later) and click the 
Next button. 
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Select Features – select the first 
four components as shown, and 
click the Next button. 

TwinCAT IO – Allows the direct 

access to IO via a DLL. Can be 
installed with TwinCAT PLC or 
TwinCAT NC PTP (see Installation 
Levels above). 

TwinCAT Scope View – Diagnostic 

tool (see Scope View section near 
the end of this manual). 

TwinCAT Cam Server – Fast Cam 

Server. 

TwinCAT EDS and GSD Files – 

The EDS (DeviceNet) and GSD 
(characteristic master device file, 
Profibus) makes all the settings 
available to the user for the configuration of the system. 

TwinCAT Remote Manager – Support for managing several different versions of the TwinCAT system 

manager and of TwinCAT PLC control. 

 
Choose Destination Location – 
click the Next button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select Program Folder – click the 
Next button. 
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Information System – after the installation of 
TwinCAT, the TwinCAT Information System is 
automatically installed. Click the Next button. 
 
 
 
 
 
 
 
 
 
 
Choose Destination Location – click the Next 
button. 
 
 
 
 
 
 
 
 
 
 
 
Select Features – deselect Deutsch if you want to 
save space and click the Next button. 
 
 
 
 
 
 
 
 
 
 
 
InstallShield Wizard Complete – it 
is recommended that you select Yes 
and click the Finish button to restart 
the computer and complete the 
installation. 
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Licensing 

TwinCAT must be licensed by entering a Registration Key or it will expire and cease to run 30 
days after installation. 
 
First, find and record your System ID. To find your System ID, click on the 
TwinCAT icon in the system tray and select Properties. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you have any questions, feel free to call 877 TWIN-CAT (877 894-6228) for assistance. 

Select the Registration tab.  
 
The System ID should be in 
the System ID field. Select 
the ID, copy it and paste it 
into an email. Add your P.O. 
number from purchasing the 
software (if you have it) and 
send it to your Inside Sales 
representative. 

Within 24 hours (not 
necessarily including 
weekends and holidays) you 
should receive back a new 
Registration Key. This can 
be copied and pasted in the 
Registration field. 
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Tour of the TwinCAT Environment 

Components 
There two main components to creating a PLC program in TwinCAT: TwinCAT PLC Control and 
TwinCAT System Manager. TwinCAT PLC Control is where the program is written and TwinCAT 
System Manager is where the hardware connections are configured. 
 
A third component, the TwinCAT System Service acts as the liaison between the program and 
the connected hardware on a PC that is being used as the controller. It is also used to connect to 
a training/test station so that programmers can practice and test how the program interacts with 
inputs and outputs. 
 
The TwinCAT programs can be launched in a number of ways: 

1. Click the TwinCAT icon in the system tray then select the application needed. 

  
 

2. Click the Start button, select Programs (or All Programs), select TwinCAT System and 
select the program needed. 

 
3. Double click on My Computer on the desktop (sometimes found by clicking the Start 

button), double click on the C: drive (might be different if a different drive was specified 
during installation), Double click on TwinCAT: 

a. TwinCAT PLC Control is found in the PLC folder and is called: TCatPlcCtrl.exe 
b. TwinCAT System Manager is found in the Io folder and is called: 

TCatSysManager.exe 
As mentioned in number 3 above, TwinCAT System Manager and TwinCAT PLC Control are the 
two programs that will be used the most. 
 
TwinCAT System Manager is used to configure 
the hardware and ultimately to attach or 
download the PLC program to the hardware. 

TwinCAT PLC Control is the programming 
environment. This is where the actual PLC 
program is written. 
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TwinCAT, making Windows a Real-Time Operating System 

The importance of precise timing can not be stressed enough in automation. Almost every 
automation application has at least a safety aspect and many have the potential for very 
expensive mistakes. 
 
Leaving the control of a system up to the unpredictability of Windows could be catastrophic. 
TwinCAT effectively turns a Windows computer into a real-time computer. 
 

Real-Time Computing 
Real-time computing basically means that there is a deadline to when the system responds after 
a request. Normally, PCs respond when they get around to it. Conversely, in a real-time system, 
the system must process the request in a given timeframe. 
 
Another concept that is related here is deterministic computing. This can be described as always 
getting the expected result given the exact same input. 
 
For this to happen, the initial state of the system must always be exactly predictable. Next we will 
look at what is required of a computer system to achieve this and TwinCAT’s role. 
 

Kernel 
The kernel is the part of a computer’s operating system that links hardware to software. In other 
words, whenever you do anything on a computer, no matter what the program, at minimum, the 
RAM and the processor are accessed; the kernel handles these access requests. 
 
When TwinCAT is installed, Microsoft’s kernel is taken over by TwinCAT. This is because 
Microsoft’s kernel is built for compatibility and TwinCAT is built for perfect timing. 
 
Within each tick (see below), TwinCAT regulates how system resources are allocated. This 
allows the PC to operate in a deterministic, real-time way. Furthermore, Beckhoff’s patented RT 
(real-time) kernel is capable of surviving crashes and “blue screens” since it runs outside of the 
Windows operating system. 
 

Tick 

The smallest clock unit considered by a computer is called a tick (sometimes referred to as a 
runtime). The actual length of the tick is dependent on processor speed, RAM and other 
variables, but is usually described in milliseconds. 
 
Normally the Windows OS decides what to do in each tick. When TwinCAT is installed, it takes 
over control, allocating space within each tick for TwinCAT operations before handing control 
back to Windows. By default, TwinCAT reserves 80% of each tick but this can be configured up to 
90% in the Realtime Settings. 
 
Within each portion of each tick governed by TwinCAT, up to four runtimes can be run in order. 
Within each runtime, four tasks can be run in order. And within each task, a number of Projects 
(determined by the processor) can be run in alphabetical order. 
 
TwinCAT always gives control back to Windows at the end of the tick. If the task isn’t done, it is 
resumed at the beginning of the next tick from where it had stopped. If more than one task is 
running but one task does not finish or does not even start, it runs first at the beginning of the 
next tick.  
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To change the settings the Realtime System must be running. Click 
on the TwinCAT icon in the system tray and select Start. Then click 
on the TwinCAT icon again and select Realtime Settings. 

Latency 
Latency describes the time it takes the system to respond to a 
request. Even though every attempt is made to control the behavior 
of the system, some latency is unavoidable. 
 
The actual latency is displayed dynamically in the Realtime Setup (see 
Tick above). In the lower left-hand corner is the Actual System latency 
field that continuously updates as it monitors the computer processor. 
This is showing how late the central system tick arrived. 
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Configuring Hardware with TwinCAT System Manager 
Two operations are performed when attempting to identify and configure hardware connected to 
the computer being used for programming and/or acting as the PLC: Append and Scan. 
 
Append is used when no hardware is attached. Scan is used to find hardware that is attached. 
 
When looking at the left pane of the System Manager window, Everything from I/O - Configuration 
on down is hardware related. Everything above I/O - Configuration is software related. Different 
options will be listed depending on what was installed, but the common configurations are: 
 
SYSTEM - Configuration – Describes how the system will run, especially run-time settings. 
PLC - Configuration – Describes how the PLC program will run, particularly how it will run 
autonomously. 
I/O - Configuration – Describes what hardware is attached and specifies communication 
parameters.  
 
Since hardware constitutes I/O, 
appending and scanning is dealt 
with using the I/O - 
Configuration portion of 
TwinCAT System Manager and 
specifically with the I/O Devices 
subcategory. Also, since this is 
a configuration activity, the 
system must be in Config Mode 
before an interface can be 
appended. 
 
When System Manager is told 
to append a device, a list of 
devices that can be inserted 
appears. This is a generic list 
and does not necessarily reflect 
what interfaces might actually 
exist. 
 
Devices are grouped by type which can be 
expanded to show specific devices. Though 
there may be multiple interfaces attached to 
the computer, only one device can be selected 
at a time. 
 
 
 
 
 
 
 
Each interface has to be added separately and will be listed under I/O Devices under 
I/O - Configuration. 
 
 
 

 

These instructions are for 
version 2.8 and up. If using an 
older version, please contact 
your support person for help. 
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Once the interface is added to 
the list of I/O Devices, then 
that interface can be scanned 
to discover what hardware is 
attached. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If an actual existing and functioning interface is 
scanned, a list of boxes will be displayed. This 
list is specific and shows only the hardware 
detected via that interface. 
 
The selected box can then be added to System 
Manager. System Manager then displays the 
selected box(es) under the device that was 
appended under I/O Devices under 
I/O - Configuration. 
 
I/O - Configuration is really only concerned with I/O, that is, input and output. For this reason, 
some Bus Terminals also called “slices”, such as those that deal with electrical termination, are 
not generally displayed. 
 
It’s critical to know what mode TwinCAT is in during development. The mode can always be 
identified by the icon in the system tray and sometimes in the message in the lower right corner of 
the application: 

 Config Mode Run Mode Stopped Changing Free Run 

 This is the mode 
that is required 
for development. 

This is the 
mode that 
is required 
for running 
the PLC. 

Neither 
development 
nor 
operations 
can be 
performed. 

This should 
only be 
visible for an 
instant 
between 
state 
changes. 

This is a 
special 
mode for 
testing 
connections 
in System 
Manager. 

TwinCAT 
System Tray icon      

TwinCAT 
System Manager     

Flashes 
between

 
and

 
TwinCAT 
PLC Control     
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Lab 1: Append and Scan 
Purpose: In this lab, you will be using TwinCAT System Manager to identify the hardware 
attached to the computer. You will also see the representation of the attached hardware in 
System Manager and how it is different from the physical hardware as described above. 

Working Directory 

Here you will make a folder on the Desktop in which you will save all the files from the 
subsequent labs: 
 
1. Close any applications, clicking the No button if asked to 
save. Right click on the desktop, bring your mouse down to 
New and select Folder. 
 
2. Type your name and hit the Enter key on the keyboard.  
 
 
 
 
 

 

Hardware Configuration 

3. Click on the TwinCAT icon in the system tray. 
 

 
3a. Select System Manager. 
 
 
 
 
 
 
 
 
 
3b. Start a new configuration by clicking the New button (Ctrl+N). 

 
 
 
4. Enter Config mode by clicking the Set/Reset TwinCAT to Config Mode button (Shift+F4). 
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4a. Click on the OK button to Restart TwinCAT System in Config Mode. 
 
5. If necessary, click on the  
next to I/O - Configuration 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. Right-click on I/O Devices 
and select Append Device 
 
 
 
The purpose of appending is 
to be able to configure 
hardware when offline or if the 
Fieldbus being configured is 
unavailable. 
 
 
 
 
 
 
 
 
7. Click on the  next to Ethernet then select 
Virtual Ethernet Interface. 
 
7a. Click the Ok button. 
 
 
 
  
 
 
 
 
 
 
 
 
 

? 
 

 

If Append Device is grayed out, 
then the system is not in config 
mode. Click the Config Mode 
button (see step 2 above) or 
(shift-F4). 
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8. Right click on Device 1 
(Virtual-Ethernet) and select 
Scan Boxes.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
9. Click on the check box next to BK9000-7 
(exact number might be different) to select. 
 
9a. Click the OK button.  
 
 
 
 
 
 

10. Click on the  next to 
BK9000-7 (will be the same 
device name as discovered in 
step 7 above). 
 
Notice that all the input and 
output slices are listed but not 
all the other types of slices 
existing in the box. 
 
Only controllable elements 
need be displayed. Other 
elements, such as power 
terminators are 
unprogrammable so there is 
no need having them clutter 
up the System Manager. 
 
 
 

 
 
 
 
 
 
 

? 
 

 

For System Manager to find 
attached devices, you may 
have to either turn off 
Windows Firewall or open 
ports bf02 and bf03. Contact 

support help if necessary. 
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Testing Configured Hardware 
TwinCAT System Manager 
can also be used to test the 
attached hardware to ensure 
that everything is configured 
correctly and functioning. 
Basically, inputs will be 
captured and outputs will be 
forced. 
 
Once the hardware is “seen” 
by TwinCAT System Manger 
by way of appending and 
scanning, individual slices can 
then be queried and acted 
upon. This process mimics 
how the box will react when 
connected to a PLC. 
 
The terminals are separated into the different channels that are available for communication. The 
channels contain the direction of communication available to that terminal. 
 
It has already been discussed how System Manager is configured in Config Mode, a sub-mode of 
Config Mode is Free Run Mode which allows for checking inputs and outputs. This mode 
empowers System Manager to operate like a real-time PLC where inputs and outputs are 
controlled manually instead of via a PLC program. 
 
Watching an input on a particular slice while its associated, physical input is tripped will result in 
an on-screen response. This is displayed in a built-in scope within System Manager. Likewise, 
simulating an output using System Manager will result in a response in the physical hardware. 
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Lab 2: Testing I/O 
Purpose: In this lab you will learn to manually check the hardware connections. Besides ensuring 
that the hardware is functioning before applying a program, this can be one of the steps in 
troubleshooting a system. 
 
1. Returning to your previous 
lab bench, start by clicking on 
the  next to Term 2 then 
click on the  next to 
Channel 1. 
 
1a. Select Input. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Enter Free Run mode by clicking the Toggle Free Run State button (Ctrl+F5). 

 
 
 
3. Click on the Online tab.  
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3a. Flip the first switch on the demo box to On (your demo box 
might look somewhat different). 
 
 
 
 
 
 
 
 
 
 
 
3b. The scope in TwinCAT 
System Manager should 
respond. 
 
3c. Also notice that a LED on 
the Digital Input slice (yellow) 
has illuminated. 
 
3d. Flip the first switch on the 
demo box to Off. 
 
 
 
 
 
 
 
 
 
4. Click on the  next to 
Term 3 then click on the  
next to Channel 1. 
 
4a. Select Output 
 
5. Click the Write button. 
 
5a. Click the 1 button. 
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5b. Notice the scope in 
TwinCAT System Manager. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. Check the demo box for light 1. 
 
6a. Also notice that a LED on the Digital Output 
slice (red) has illuminated. 
 
6b. Click the Write button again. 
 
6c. Click the 0 (zero) button. 
 
 
7. Click the Save button. 

 
 
 
8. Select the folder you made in the beginning of Lab 1. 
Click on the Save in field, it should be at the bottom of the 
pull down menu. Otherwise, click on Desktop and it should 
be listed there. 
 
 
 
9. Type First_Project in the File name field. 
 
9a. Click the Save button. 
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PLC programming with TwinCAT PLC Control 
As part of the Beckhoff’s commitment to providing one solution for all of your PLC needs, 
TwinCAT PLC Control offers a programming environment with all the features and support 
necessary to meet the requirements of any PLC application. This includes five IEC standard 
programming languages plus a new variation on FBD called CFC which is not yet a standard: 
 
IL (Instruction List) – is a low level language with a structure similar to a simple machine 
assembler. Though it can be used to write tight code for simple yet critical operations, it is the 
least documented language of the IEC standard, because of this, it might not be the best choice 
for beginner programmers. There is a proposal to improve IL so a future version might make it a 
better choice. 
 
LD (Ladder Diagram) – aka RLL (Relay Ladder Logic) is representative of electrical wiring 
diagrams, specifically ones used in the car industry. Subsequently it is easy for people familiar 
with simple electrical systems and is well accepted by electricians and plant technicians. 
-Its main deficiencies are its lack of scalability and the variation of symbols used throughout the 
industry. 
 
FBD (Function Block Diagram) – is a graphical language which effectively depicts a system in 
terms of the flow of signals between processing elements and is very similar to signal flows 
illustrated in electronic circuit diagrams.   
 
SFC (Sequential Function Chart) – is a graphical language developed largely by a French 
standards group called Grafcet. It is structured as a series of steps which intuitively describe 
sequences of operations.  
 
ST (Structured Text) – is a high level language with some similarities to PASCAL and BASIC. 
 
CFC (Continuous Function Chart) – is a variation of FBD not yet a part of the IEC standard. In 
addition to the display of FBD, CFC also shows the resource and task assignments. 
 
PLC Control allows for any number of the languages to be used in the completion of a Project. 
This not only allows the programmer to select the best method to design a system, but allows that 
programmer to switch between tools as the specific operations within that system demand. 
 
A complete TwinCAT program is called a Project. A Project can contain three kinds of objects: 
Program Organizational Units (POUs), data types and resources, plus libraries which are 
collections of the afore mentioned objects which can speed the writing of new code and give the 
Project added power such as connecting to third party hardware.  
 
A POU basically contains variables and the use of those variables. Data types are additional 
types of information that the variables designated in the POU(s) can be declared to contain. And 
resources are elements that multiple POUs may work with; most common are global variables, 
but also include hardware configuration tools, logging tools and the Library Manager (which lists 
available objects in any attached libraries). 
 
Understanding the specifics of how TwinCAT programs are structured is not necessary to 
complete this training course. As one begins creating more complex programs, the above 
description will become clearer and more useful. 
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TwinCAT PLC Control is separated into four frames: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Editor Windows – This where the code is written. There will be an Editor Window for each object 
in your Project and each Editor Window will conform to the language used for that object. In the 
LD example above, there is a Code Editor that also includes a Declaration Editor: 
 

Declaration Editor – This is where the variables can be manually assigned though 
generally coding is done in the Code Editor where auto declaration does the work which 
is displayed in the Declaration Editor. In Run mode, this pane will also show the states of 
the variables. 
 
Code Editor – This is the main area for writing the code. Variables such as inputs and 
outputs can be added with a point and click methodology. In the LD example shown, the 
ladder rungs are displayed. As assignments are made, the Declaration Editor 
automatically updates to show the change. 

 
Messages – As the program is compiled (built) and run, feedback is displayed here. Detected 
problems with the program will be identified here. 
 
Object Organizer – This is where all the objects of the Project are listed. There is a tab for each of 
the three types of objects: POUs, Data types, and Resources. There may also be a tab for 
Visualizations where interactive graphic representations of inputs and outputs can be made. 
 

Message 

Object Organizer 

Code Editor 

[Other Editors] 

Message Window 

Editor 

Windows 

Declaration Editor 
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Lab 3: TwinCAT PLC Control Familiarization 
Purpose: In this lab, you will be creating a simple PLC program. This section is not intended to be 
even an introductory programming course; it is merely to acquaint you with the functionality of 
TwinCAT and basic procedure to start a project. 
 
1. Click on the TwinCAT icon in the system tray. 
 
1a. Select PLC Control. 
 
1b. Click the OK button when presented with the Could not open 
project/library alert.  
 
1c. Go under the File menu to New. 
 
 
 
 
2. Select PC. 
 
2a. Click on the OK button. 
 
 

 
3. Select LD under Language of the POU. 
 
3a. Click the OK button. 
 
 
 
 
 
4. Right click in the Code 
section of the programming 
window. 
 
 
 
 
 
 
 
 
 
 
5. Select Contact (Ctrl+K). 
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6. Click the red ???. 
 
6a. The ??? should highlight. 
If instead you see a blinking 
line between ?s, than double 
click the ???. 
 
 
 
 
 
 
 
 
7. Type b_100. 
 
7a. Hit the Enter key on the 
keyboard. 
 
 
 
 
 
 
 
 
 
8. Type %I* (percent sign, capital “I”, asterisk) 
in the Address field. 
 
8a. Type My First Contact in the Comment 
field. 
 
8b. Click the OK button. 
 
9. The Declaration area 
should update to reflect the 
changes. 
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10. Right click in the Code section again. 
 
10a. Select Coil (Ctrl+L). 
 
 
 
 
 
 
 
 
 
 
 
11. The ??? should already 
be selected, that is, they 
should be blue. If not, click on 
the red ??? to select it 
 
11a. Type b_200. 
 
11b. Hit the Enter key on the 
keyboard. 
 
 
 
 
12. Type %Q* in the Address field. (“Q” is 
used as “O” might be misread as a zero.) 
 
12a. Type My First Output in the Comment 
field. 
 
12b. Click the OK button. 
 
13. The Declaration area 
should update to reflect the 
changes. 
 
 
 
 
 
 
 
 
 
 
14. Go under the File menu to Save As. 
 
 
 
 
 
 
 

? 
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15. Select the folder you made in steps 1 and 2. 
Click on the Save in field, it should be at the bottom of the 
pull down menu. Otherwise, click on Desktop and it should 
be listed there. 
 
 
 
 
 
 
 
 
16. Type First_Program in the File name field. 
 
16a. Click the Save button. 
 
 
 
 
 
 
 
 
 
17. Go under the Project menu to Build (Ctrl+F8). 
 
17a. There should be 0 (zero) errors reported at the bottom of the 
screen. It’s OK to have any number of warnings. 
 
 
 

 
 
 
 
18. Go under the File menu to Save. 
 
18a. The folder on the desktop should contain the 
following files. 
 
 
 
 

 
 
 
 
  

If the .tpy file did not get 
created, there was probably an 
Error in the program when 
building. Remember that while 
there can be warnings, there 

must be NO errors. 
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Connecting the PLC Program to the Hardware 
The System Manger is the bridge between a PLC program and the hardware being controlled. It 
assigns which hardware input is controlled by which software input. It also connects the hardware 
outputs to software outputs so the PLC programs can monitor and react to the changes in the 
hardware states. 
 

Lab 4: Putting it all together 
Purpose: In this lab, you will be building on the knowledge gained in the previous labs to take the 
program you wrote and the hardware you configured and get them to communicate together. 

Hardware Configuration 

1. Switch to Untitled - TwinCAT System 
Manager using the Task Bar. 
 
2. Right click on PLC - 
Configuration (scroll up in the 
left pane if necessary) and 
select Append PLC Project. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Find the folder you made in steps 1 and 2. Select 
First_Program.tpy and click the Open button. 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 

If input(s) are not showing 
up, the wrong program was 
probably Appended. Go 
under the File menu in PLC 
Control and select Save as 
to see where that version of 

the program was saved. 
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3a. If necessary, click on the 
s next to Term 2 and 

Channel 1. 
 
3b. Double click on Input. 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Select MAIN.b_100. 
 
4a. Click the OK button. 
 
-The Input icon now has a little arrow on it 
indicating that it is linked to a control. 
 
 
 
 
 
 
 
 

 
5. If necessary, click on the 

s next to Term 3 and 
Channel 1. 
 
5a. Double click on Output. 
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6. Select MAIN.b_200. 
 
6a. Click the OK button. 
 
6b. Click the Save button (Ctrl+S). 
 
 
 
 
 
 
 
 
 
 
7. Click on the Activate configuration button. 

 
 
 
 
7a. Click on the Yes button that Document is modified! 
 
7b. Click on the OK button to Activate Configuration. 
 
7c. Click on the OK button to Restart TwinCAT System in Run Mode. 
 
-The system should now be in run mode and both System Manager and the TwinCAT icon in the 
system tray should reflect this. See page 18. 
 
-Notice that the WDG LED on the Bus Coupler is lit solid and the ACT LED is flashing quickly. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 

There are three ways to 
activate a configuration: 

 The Activate button 

 Under the Actions menu 
and selecting Activate 
Configurations 

 Ctrl+Shift+F4 
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Launching the PLC 

8. Switch to TwinCAT PLC Control using 
the Task Bar.  
 
9. Go under the Online menu and select Login (F11). 
 
9a. When notified that The program has changed, click on 
the Yes button to Download the new program. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
10. Go under the Online menu and select Run (F5). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
10a. The response should be 
FALSE for both the input and 
the output. 
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11. Flip the first switch on the 
demo box. 
 
11a. The response for both 
input and output should now be 
TRUE and the contact and the 
coil should now be blue. 
 
 
 
 
 
 
11b. The first light on the demo box should also be 
lit. 
 
11c. Also notice that LEDs are lit on both the 
Digital Input slice (yellow) and the Digital Output 
slice (red). 
 
 
 
 
12. Exit out of both PLC Control and System Manager, clicking the Yes button if asked to save. 
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Boot Project 
 
Most if not all system critical operations require the ability to automatically restart a system after a 
power-failure. As part of the previous labs, the PLC program was downloaded to the Bus Coupler, 
but that program is erased when power is cycled to the Bus Coupler. 
 
Besides the system critical nature mentioned above, another way to help decide if a Boot Project 
is something to consider is to think about what would happen after a long shutdown. If this PLC is 
to control a conveyor belt of rocks, upon restoring power, there is no reason not to start up the 
belt again and deliver the rocks. On the other hand, if it is conveying cabbages instead, it would 
make sense to wait until the potentially rotted product is inspected and perhaps removed before 
manually restarting the belt. 
 
TwinCAT can be used to save a PLC program to the Bus Coupler so that it will be present and 
can initialize after a power cycle. This is accomplished by creating a Boot Project. 
 
The Boot Project must be configured in three steps: 
1. Setting the PLC program as a Boot Project 
2. Setting the TwinCAT system to Auto Boot 
3. Telling the TwinCAT system which Boot Project to load 
 
Step 1 is done in PLC Control and steps 2 and 3 are done in 
TwinCAT System Properties. There is a secondary choice 
when configuring the second step above: Load/Store Retain 
Data. This is only checked if there is information that might 
have been written to a variable that needs to be referenced 
when restarting the system. If unsure whether you need this or 
not, please contact your Beckhoff representative. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Make sure to save all 
changes to the PLC 
program. Not only is this a 
good habit in general, but 
more importantly, at auto 
restart, only the last SAVED 

version will be loaded. 
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Lab 5: Creating a Boot Project. 
Purpose: In this lab you will learn to configure a Project as a Boot Project and how to configure 
the System Properties to automatically launch the project. 
 
 
1. In PLC Control, go under the Online menu and 
select Login (F11) then again to select Create Boot 
Project. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Double click on the TwinCAT icon in the system tray.  

 
3. Select the System tab and select the Enable radial button.  
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Select the PLC tab. 
 
4a. Click the Browse button and find your folder on the desktop. 
 
4b. Put a checkmark in Run-Time System in both the Boot 
Project and Lead/Store Retain Data fields.  
 
4c. Click the Apply button. 
 
4d. Click the OK button. 
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Scope View 
Also installed with TwinCAT is a diagnostic tool called TwinCAT Scope View. Scope View is 
something of a virtual oscilloscope and works with System Manager and PLC Control together to 
not only offer another method of visualizing results, but will aid in tweaking the system, especially 
in motion applications. 
 
Both System Manager and PLC Control need to be running for Scope View to be configured. 
Once configured however, as long as the program has been downloaded to the hardware and is 
running, Scope View can be used by itself to monitor the box. 
 

Lab 6: Configuring and Using Scope View. 
Purpose: In this lab you will learn to configure Scope View to monitor your project (both the PLC 
program and the hardware being controlled). 
 
1. Launch System Manager. 
 
2. Go under the File menu and select Open (Crtl+O).  
 
 
3. Find your folder on the desktop and, select 
First_Project.tsm and click the Open button.  
 
 
 
 
 
 
 
 
 
4. Click on the Activate configuration button. 

 
 
 
 
4a. Click on the Yes button that Document is modified! 
 
4b. Click on the OK button to Activate Configuration. 
 
4c. Click on the OK button to Restart TwinCAT System in Run Mode. 
 
5. Launch PLC Control. 
 
6. Go under the File menu and select Open (Ctrl+O). 
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7. Go to your folder on the Desktop, select 
First_Program.pro and click the Open button.  
 
 
 
 
 
 
 
 
 
 
 
 
 
8. Go under the Online menu and select Login (F11). 
 
8a. When notified that The program has changed, click on the Yes button to Download the new 
program. 
 
 

9. Click the Run button  (F5). 
 
10. Click the Start button, then go to Programs 
(or All Programs) then TwinCAT System then 
TwinCAT Scope View. 
 
 
 
 
 
 
 
 
 
 
11. Right click on Scope and select Add Scope View. 
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12. Click on the Properties tab in the bottom 
section of the screen. 
 
12a. Click on the Ringbuffer radial button. 
 
 
 
 
 
13. Right Click on Scope View 1 and select 
Add Channel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
14. Click on the Acquisition tab and click 
on the Change button. 
 
 
 
 
 

 
15. Click on the Reload Symbols 
button. 
 
15a. Select MAIN.B_100. 
 
15b. Click the OK button. 
 
 
 
 
 
 
 

16. Click on the Start button  (F5). 
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17. Flip the first switch on the demo box to On. 
 
18. Scope View displays the change in state.  
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Documentation 
A number of sources of information are available when learning about, using specific Beckhoff 
tools, Beckhoff products and services and company information. As a customer of Beckhoff, all of 
this information will be at your disposal. 

Beckhoff Information System 

By far, the most complete source of information is the Beckhoff Information System. It includes 
information about every Beckhoff product, its use and interoperability. When TwinCAT is installed 
from the CD, the complete Information System is automatically installed. If TwinCAT was installed 
from a download, a slimmed-down version may have been installed to save download time. The 
full version can also be downloaded from the Beckhoff site. 
 
Arguably, Information System’s greatest asset is in its help with troubleshooting. Information 
System includes explicit details of programming and hardware elements. This includes error 
codes plus their causes and potential remedies. 
 
To access Information System, click the Start button, then Programs (or All Programs) then 
BECKHOFF, then Information System and finally the language of your choice. 
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There are three main ways to find information in the Information System: 
 
Contents shows a tree of topics that can be browsed. 

 
 
Index takes a keyword and shows items specified as being related to that keyword.  
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Search returns every page that contains the entered search term. 

 
If you find something close to what you are looking for in a search, try clicking on the Contents 
tab to see where the selected page falls in the tree. You can then browse from there to pinpoint 
the information you require. 
  

Other resources 

www.beckhoff.com 

This is the official website of Beckhoff Automation. At this site you will have access to company 
information, including news, training locations, contact information, products and services. 
 

PC Control 

This printed, monthly magazine, published by Beckhoff offers stories about companies that are 
benefiting from the incorporation of Beckhoff products plus tips, new product announcements and 
general news. It can also be read online at www.pc-control.net/english. 
 

Main Catalog 
This printed document contains all of Beckhoff’s products and services and also includes some 
company information. See the I/O section in this manual for a description of model numbering 
and color scheme. 
 

Products & Solutions 
This CD set includes a CD with the entire website, Main Catalog, documentation, all of the 
publications of PC Control available at the time plus a second, installation CD of Beckhoff 
software products. 
 

General PLC Information 
For non-company specific information on the PLC standards, programming and more, visit 
www.plcopen.org. 
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Glossary 
 
ADS (Automation Device Specification), an 
interface that utilizes a Message router to 
communicate between ADS devices over 
TCP/IP. 
 
Box, a Bus Coupler, Bus Controller or a 
Fieldbus Box. It can also refer to the lab 
device used in training. 
 
Bus Terminal (aka slice), the part of the box 
that handles I/O and sometimes added 
communication and specific electrical 
requirements. 
 
CFC (Continuous Function Chart), a version 
of FBD that is not yet an IEC standard PLC 
programming language. 
 
CNC (Computer Numerical Control), 
connected to a machine to repeatedly make 
items and whose program can be updated 
or replaced to change production. 
 
Deterministic computation, given an initial 
state of a system, the system will always 
produce the same final state when given the 
same input. 
 
DIN (Deutsches Institut für Normung), 
normally used in reference to DIN rails (also 
called top-hat rails) which are used to mount 
control equipment, specifically Bus Couplers 
and Bus Terminals, inside equipment racks. 
 
DLL (dynamic-link library), a block of code 
that is called by a program but remains 
separate, generally written in higher-level 
languages. 
 
FBD (Function Block Diagram), an IEC 
standard, graphical, PLC programming 
language. 
 
Fieldbus, an industrial network system for 
real-time distributed control. 
 
Force, the act of manually changing the 
state of an input or output. Can be 
performed programmatically in PLC Control, 
virtually in System Manager or physically on 
the box. 

 
IEC (International Electrotechnical 
Commission), the world standards 
organization for electrical and electronic 
international standards. 
 
IEC 61131-3, the global standard for 
common industrial control programming. 
 
IL (Instruction List), an IEC standard, text 
based, PLC programming language. 
 
I/O (Input/Output), communication between 
a computer and its users, its storage 
devices, other computers (via a network) or 
attached hardware. 
 
Jitter, very small timing fluctuations. Used 
when discussing deterministic timings and 
usually described in microseconds. Can also 
be considered a component of task time 
when figuring response times. 
 
K-Bus, internal bus for communication and 
power between the coupler and Bus 
Terminals. 
 
Kernel, the part of a computer operating 
system that manages the system's 
resources and the communication between 
hardware and software components. 
 
LD (Ladder Diagram), an IEC standard, 
graphical, PLC programming language. 
 
Library, a collection of POUs (generally 
Functions and Function Blocks) often 
grouped together by task, that aids in 
development. 
 
Link, the means by which the hardware 
information is connected to the software 
information. 
 
Millisecond, 1000

th
 (0.001) of a second.  

 
NC (Numerical Control), predecessor of 
CNC, connected directly to a machine to 
repeatedly make a single item. 
 

http://dictionary.reference.com/browse/network
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OCX, a DLL that contains one or more 
ActiveX controls. Mainly used when linking a 
program to code written in Microsoft Visual 
Basic or .net. 
 
Online, Beckhoff uses this term to describe 
connecting to the box in real time. 
 
OS (Operating System), the software that 
runs a computer or is embedded in and runs 
Fieldbuses. 
 
PLC (Programmable Logic Controller), a 
small special-purpose computer used to 
automate machines. 
 
PLC Control (TwinCAT PLC Control), the 
Beckhoff PLC programming environment. 
 
POU (Program Organization Unit), functional 
elements within a PLC program as 
described by IEC 1131-1. 
 
Real Time, a live connection to hardware. 
 

Real-time system, a computer system that 
is forced to respond to an input in an 
explicitly allotted time. 
SFC (Structured Function Chart), an IEC 
standard PLC programming language that is 
both graphical and textual. 
 
Slice, alternate name for Bus Terminal. 
 
ST (Structured Text), an IEC standard, text 
based, PLC programming language. 
 
System Manager (TwinCAT System 
Manager), the Beckhoff hardware 
configuration tool. 
 
Tick, The smallest increment of time as 
measured by a computer system, usually 
measured in milliseconds. 
 
TwinCAT (The Windows Control and 
Automation Technology), all the PLC tools 
and system modification components 
offered by Beckhoff Automation. 
 
 

http://en.wikipedia.org/wiki/Programmable_logic_controller
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